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TAKE THE WORLD BEST COURSES;”ONEINE.

- ,“..Jj" ‘ 3 \A

Home Page

Click on the login button on the top right corner of screen

A login page will pop up ( see next image)

Input your login details

Note that the LMS login details are the sane as the SRMS Login details

LOG IN

Lost password?

LOG IN AS A GUEST
COOKIES NOTICE

‘&A

Login Page
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=zl Upcoming events

E Navigation
v Dashboard
A Site home

> Site pages \
v My courses

> ABS311

E Recently accessed items
There are no upcoming events

Go to calendar... }

Calendar
No recent items

—

‘E Course overview

All v | Search Sort by course name v Card v ‘
v 3 4 5 e 7 8

3

d

9 10 11 12 13 14 15

18 19 20 21 22

25

Full calendar = Import or expor.

26 27 28 29

Airport Safety & Security
FIRST

3. Dashboard Page

1: Navigation Panel
The navigation pane is at the left side of the screen.This enable you to navigate to the site home,
site pages and your enrolled courses

2: Upcoming event block
This block notify user to see what event is coming. It could be assignment,Test or quiz.

2.1: Calendar
The calenda block help to keep up to date the activities and event that is upcoming.

3. Course overview
The course overview block enable student and lecturer to see the course they are enrolled into.
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4.Course Page

Dashboard / My courses / ABS311

Turn editing on

E Navigation

v Dashboard

A Site home

> Site pages FORUM

~ My courses . Announcements

v ABS311

> Participants
U Badges
® Competencies
&8 Grades Vv Topic 1l
> General

v General Collapse all

> Topic 1

> Topic 2 ASSIGNMENT View
> Topic 3 Test Assignment

Make a submission
> Topic 4

Quiz View n
. . v
u Administration First C.A Test

Course Page ( Lecturer View)
To see all the feature on this course page click on the turn editing on button

AN s,

Dashboard / My courses / ABS311 Turn editing on

E Navigation

v Dashboard

A Site home

> Site pages FORUM

~ My courses Announcements

v ABS311

> Participants
U Badges
& Competencies
&8 Grades ¥ Topicl
> General

v General Collapse all

> Topic 1

> Topic 2 ASSIGNMENT Ve
> Topic 3 Test Assignment

Make a submission
> Topic 4

o ) Quiz View n
u Administration First C.A Test
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Dashboard / My courses / ABS311

E Navigation

v Dashboard

A Site home FORUM
> Site pages Announcements ¢
v My courses

v ABS311

v General ¢
LX-2

Turn editing off

Collapse all

> Participants o
U Badges Add an activity or resource

& Competencies

88 Grades

Add topic
> General

> Topic 1
> Topic 2
> Topic3 Vv Topiclés

> Topic 4
ASSIGNMENT
u Administration Test Assignment &

Editing Mode view

5.Features

You will see add an activity and resource. Then click on it

= E

Make a submission -

Add an activity or resource

Search

All Activities Resources
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Resource and activities view

Add an activity or resource =
Search
All Activities Resources

B
4

B =E B

Assignment Chat Choice Database External tool Feedback
o [ o (i) T (3] ir L] r (3] 7 [
=2 E = =
SCORM
Forum Glossary H5P Lesson Quiz package
pokg o h g (i) i L3 ] Pk g (3] hk g (3] 7 o
el E3 =
=
Survey Wiki Workshop
7 (i) o7 o i (3]
Features for activities
Add an activity or resocurce =
Search
All Activities Resources

B & B0 B B B

IMS content

Book File Folder package Label Page
v O i (1] wr O v O W O ivT ©
URL
W O

Features for resources

https://ntibay.com



LMS User Guide

Note that you can also starre some of the features to easy you from searching for what tools to use.
To do this you will click on the star icon to add a feature to starred

Add an activity or resource x
Search
All Activities Resources

B
B
B
-+
o
B

Assignment Book Chat Choice Database External tool
i O O T © w O T O W O
Feedback File Folder Forum Glossary H5P
¥ 6 v O v O b i ] v & i O
(] {:> g
IMS content SCORM
package Label Lesson Page Quiz package
W O O T © w O <A i W O
Survey URL Wiki Workshop
w6 b R i ) v © i O
Add an acrtivity or resource =
Search
Starred Al Activities Resources
[&] =l E3
Assignment File Quiz Survey
i [ i (3] i (i ] i &

Features in starred view.
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5.How to add Activities and Resource

Step 1: click on the turn editing on button

Dashboard / My courses / ABS311 Turn editing on
E Navigation
V¥ General Collapse all
v Dashboard
A Site home
> Site pages FORUM
~ My courses Announcements
~ ABS311
> Participants
U Badges
& Competencies
B8 Grades v Topicl
> General
> Topic 1
> Topic 2 ASSIGNMENT View
> Topic 3 E Test Assignment Make a submission
> Topic 4

Quiz View
L . Z .
n Administration First C.A Test

Step 2: click on the add an activities or resources button

Dashboard / My courses / ABS311 Turn editing off

E Navigation

v Dashboard
A& Site home FORUM
> Site pages Announcements "
~ My courses
v ABS311

> Participants 5 -
U Badges Add an activity or resource

& Competencies
&8 Grades
> General

Vv General ¢ Collapse all

R -2

Add topic

> Topic 1
> Topic2
> Topic3 v Topiclé
> Topic4

B ASSIGNMENT View 3
J Administration Test Assignment &' Make a submission

Step 3: select what features to use ( for example to add a e-content) select file

https://ntibay.com
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Add an activity or resource X
Search
All Activities Resources

B
B
B
B

Assignment Book Chat Choice Database External tool

w O w O w O w O w O w O
a B B o

Feedback File Folder Forum Glossary H5P
w O w O w O w O w O w O
B

IMS content SCORM
package Label Lesson Page Quiz package
w O w O w O w O w O w O

&
0
o

Survey Wiki Workshop

w O w O w e w O
Step 4: set up the file and upload the e-content for your local computer/device)
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n Adding a new Filee

Expand all
v General
Name (]
Description 1 A~ B I == == % O @mE ¢ WA ©
z
D Display description on course page @
Select files Maximum size for new files: 200 MB
(] H2HEB
B Files
Add title of the file
Select files Maximum size for new files: 200 MB
0O D HEmD
® Files

You can drag and drop files here to add them.

v Appearance

“~

Display e Embed
O Show size @
O Show type @
O Show upload/modified date @

Show more...
Display resource description

> Common module settings u

To select file ( document or multimedia or audio)
You can drag and drop or you click on empty arrow pointing down to navigate you to where your file
is located in the local device

https://ntibay.com
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—

File picker x

7n Content bank 4=

T Server files

. Attachment
n Recent files

Choose File | No file chosen
&a Upload a file |

Save as
A& URL downloader

=

#n Private files

9 Wikimedia Author

lecturer demo

Choose licence @

Licence not specified v

Upload this file

- e e L S L s

Select upload a file, click on the choose file button to choose a file and click on the upload this file
button
Note: convert your e-content file to pdf format.

https://ntibay.com
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> Common module settings
> Restrict access

v Activity completion

Completion tracking e Show activity as complete when conditions are met %

Require view Student must view this activity to complete it

Expect completed on e 6 % October  # 2023 ¢ 07 % 43 4 M OEnable
> Tags

> Competencies

O Send content change notification @

© Required

Ensure you set up activity completion as “show activity as complete when conditions are met.”
Check the what condition is appropriate .

Click on any of the save buttons

https://ntibay.com
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7.How to create Assignment
Apply step 1 and Step 2

Select Assignment Feauture

Add an activity or resource

Search

All Activities Resources

Assignment

B
w0 A

Feedback File
w O w O
IMS content

package Label
w O w O

&
&

Survey URL
w O w O

Chat
v O

Folder
w O

B
©

Lesson

w 0

B

Wiki
w_ 0

Choice
w O

Forum

w O

Page
w 0

ps1

Workshop
w O

Database External tool

w O v O

SCORM
Quiz package
w O w 0
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Step 3

» Adding a new Assignment to Topic 1

Expand all
v General
Assignment name o P
Description 1 A B I EEEE %% | 0@ NG @
&
D Display description on course page @
Activity instructions © 3 A B I =EE=EE %% 0 @R S ™A ww O
Set up the assignment by naming the assignment.
You can make use of the description to imput the assignment question or you upload the
assignment question as a file.
Additional files 2] Maximum size for new files: 200 MB
0 HE®N
® Files
You can drag and drop files here to add them.
O Only show files during submission @
+ Availability
Allow submissions from © 6 # Ocober # | 2023% 00¢ 00% fA @Enable
Due date 2] 13 % October % 2023 % 00 % 00 # £ EEnable
Cut-off date 2] & Ociober & | 20234 | 074 47 & B4 OEnable
Remind me to grade by © 20% October & 20234 00%  00% {8 EEnable
Always show description @

Set up the availability section as seen in the image above.

https://ntibay.com
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v Submission types

Submission types Online text® ® File submissions @

Word limit (2 2000 Enable

Maximum number of @ 20 %
uploaded files

Maximum submission size @ 2 MB

“

Accepted file types 2] * Choose  All file types

Set up the assignment submission types section as seen in the image above

Either the online text or file submission is allowed

Online text: enable student to type the assignment inside the application

To enable this ( set up the word limit by checking the enable)

File submission: enable student to upload assignment document into the application.Choose the
accepted file types ( select All file types)

Accepted file types

O All file types

O Archive files .7z .bdoc .cdoc .ddoc .gtar .tgz .gz .gzip .hqx .rar .sit .tar .zip
Expand
0O Audio files .aac .aif .aiff .aifc .au .flac .m3u .mp3 .m4a .oga .ogg .ra .ram .rm
wav .wma
Expand
O Audio files natively supported by browsers .aac flac_mp3.m4a
.Oga .0gg .wav

Expand

0 Audio files used on the web .aac .flac .mp3 .m4a .oga .ogg .ra .wav

Expand

0O Document files .doc .docx .epub .gdoc .odt .ott .oth .pdf .rtf Expand

O HTML track files vt Expand

-

Cancel Save changes

https://ntibay.com
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Activity Completion section

v Activity completion

Completion tracking 7 Show activity as complete when conditions are met %
Require view Student must view this activity to complete it
Require grade O Student must receive a grade to complete this activity @

Student must receive a passing grade to complete this activity @

Student must make a submission

Expect completed on e 10 October # 2023 = 19 = 32 #+ B OEnable

Activity Completion section set up as seen in the image above
> Tags

> Competencies

O Send content change notification @

© Required

Click any of the save button to sve assignment
Test Assignment

View  Make a submission

Opened: Tuesday, 19 September 2023, 12:00 AM

Due: Tuesday, 26 September 2023, 12:00 AM
Evaluation/Self-Assessment Questions (SAQs) for Unit 1.

1.  Explain the term management.

2. Describe management as art.

3. What do you understand with management as science?
4. Define the term principles of management.

5. Name nine characteristics of management principles.

6. Outline and briefly describe the Fayol's general principles of management.

assignment demo.txt 19 September 2023, 11:20 AM

View all submissions

Assignment overview( lecturer View)

https://ntibay.com
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View all submissions Grade

Grading summary

Hidden from students No

Participants 0

Submitted 0

Needs grading 0

Time remaining Assignment is due

Assignment Grading summary (Lecturer View)

8.How to Upload Question into the Question bank
Question bank is a repository of questions ranging from 10-1000 different questions types using

AIKEN format.

The Aiken format is a very simple way of creating multiple choice questions using a clear
human-readable format in a text file. (The GIFT format has many more options and perhaps is less
prone to errors, but doesn't look as straightforward as AIKEN. ) The question must be all on one line.
Each answer must start with a single uppercase letter, followed by a period "' or a bracket '), then a
space. The answer line must immediately follow, starting with "ANSWER: " (NOTE the space after
the colon) and then giving the appropriate letter.

IMPORTANT NOTES:

You have to save the file in a text format. Don't save it as a Word document or anything like that.

Non-ASCII characters like 'quotes' can cause import errors. To avoid this always save your text file in
UTF-8 format (most text editors, even Word, will ask you).

The answer letters (A,B,C etc.) and the word "ANSWER" must be capitalised as shown below,
otherwise the import will fail.

https://ntibay.com
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Here is an example of the format:

NO numbering.

\

What is the Capital of Canada?
A, Ottawa
B. Vancouver
C. Toronto
D. Montreal
ANSWER: A
€—— One line space.
What is the Capital of Alberta?
A. Dttawa
B. Calgary
C. Edmonton
D. Lethbridge
ANSWER: C

All capitalized.

The question must be a one line question
There must be a space between the colum and the answer.

Importing a question to the Question bank
Step 1: open the course page
Step 2: Click on the question bank located at the left side on the course administration block

u Administration

v Course administration
£ Settings
£ Course completion
> Users
Y Filters
> Reports
£+ Gradebook setup
> Badges
1 Import
[ Backup
I Restore
& Reset

> Question bank

https://ntibay.com
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[& usecoTPDP:Al x | @ wheretochange X | @ MoodleinEnglic X | A Themes-Mood X | @ Themes X @ MoodleinEnglic X Documentation Edit questions X+

& CcC 0 app.eleaming.flexisaf.com, % 0O % Incognito

Laravel Artisan Che... Laravel 8 Cheat She... Laravel Commands.. N Step-by-step Install.. g Clicks Genie |Getp.. @ Setting up yourdev.. e elan—Moodle The.. moodieha/moodie... O Client Area - QServ.. M Algorand Wallet

E Navigation
Questions #
¥ Dashboard
# Site home Categories
> Site pages C meet 1y bank
Export
~ My courses
 ABS311 Selecta category: | Default for ABS311 (20) s
> Participants The default category for questions shared in context 'ABS311".
U Badges No tag filters applied
& Competencies
B Grades Filter by tags. v
> General
> Topic 1 O Show question text in the question list
> Topic2 Search options &
> Topic3 Also show questions from subcategories
> Topic 4 O Also show old questions

Create a new question ...
u Administration
T* Question Actions  Status Version Created by Comments Needs Facility Discriminative Usage
v Course administration Question name / 1D number First name / Last checking? index efficiency
O name / Date
& Settings ( N Land ‘
are horizontal and vertica Admin U
Course completion - : . min User
= P lines which make equal squareson  Edit v Ready ¢ = v1 19 September 0 - N/A N/A 1
> Users ama 2023, 11:25 AM
p.
Y Filters Admin U
.= Asix-figure grid reference usuall . N e
3 Report i= Ec Y Editv  Ready s Vi 19September 0 - N/A N/A 1
eports have how many numbers? 2023, 11:25 AM -~
& Gradebook setup Considering settlement patterns, Admin User -

Select import as from the drop down as seen in the image above

Import *

Import questions from file

v File format g !
o Iken format

O Blackboard

O Embedded answers (Cloze)
O GIFT format

O Missing word format

O Moodle XML format

Expand all

> General

v Import questions from file

Import h Choose a file... Maximum size for new files: 200 MB

You can drag and drop files here to add them.

Select Aiken format as seen in the image above and click on the choose a file to navigate to you
question file.

https://ntibay.com
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File picker

n Content bank

 Server files

Attachment

Choose File | quiz.txt

Save as

7 Recent files

& Upload a file

& URL downloader
n Private files

9 Wikimedia Author

lecturer demo

Choose licence @

Licence not specified

Upload this file

Click on upload this file

Import +

Import questions from filee

v File format Q
o iken format @

O Blackboard @

O Embedded answers (Cloze) @
O GIFT format @

O Missing word format @

O Moodle XML format @

Expand all

> General

~ Import questions from file

Import h Choose afile... Maximum size for new files: 200 MB
L

C)

Once you have uploaded click on the import button.

https://ntibay.com
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Import s

Parsing questions from import file.

Importing 20 questions from file

1. The function of a map grid includes:

2. are horizontal and vertical lines which make equal squares on a map.
3. Asix-figure grid reference usually have how many numbers?

4. |dentify the most correct statement.

5. Which form of settlements have building packed together?

6. Nucleated settlements are sometimes referred to as?

7. The form of settlement which follows a road, coastline or river is?

This shows you have successful uploaded 20 question into the question bank.

9.How To create a CBT quiz

Step 1: From the course page click turn editing on button to enable editing mode.
Step 2: Click on add an activity and a resource

Step: Select Quiz

Add an activity or resource X
Search
All Activities Resources

o]
a
¢

Assignment Book Chat Choice Database External tool
w 0 w 0 w 0 g i ] w 0 w e
Feedback File Folder Forum Glossary H5P

w e w 0 w e e i ] . ©

IMS content

package Label Lesson Page

w 0 w 0 w 0 e i ]

B 3 E
(==

Survey URL Wiki Workshop

w @ w 6 w 6 v @
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= Adding a new Quiz to Topic 2o

Expand all
v General

Name o

Description

-
>
4
=
~
fii
i
il
lil
&
b3

O @R ¢ ™ ©

O Display description on course page ©
> Timing
> Grade

> Layout

Add Quiz name

v Timing
Open the quiz © 1% October ¢ 2023 # 02 ¢ 17 ¢ E8 @Enable
Close the quiz 11 ¢ | October ¢ || 2023¢ | 02¢ 17 ¢+ {2 EEnable
Time limit ® 3 minutes ¢ & Enable
When time expires © Open attempts are submitted automatically %

Set up the time by checking the enable butting to set the time to open and close quiz

https://ntibay.com
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v Layout

New page e

Show more...

v Question behaviour

Shuffle within questions 12}
How questions behave e
Show more...

v Review options @

During the attempt
The attempt @
Whether correct @
Marks @

Specific feedback @
General feedback @
Right answer @
Overall feedback @

After the quiz is closed
The attempt
O Whether correct
O Marks
Specific feedback

Never, all questions on one page #

Yes #

Deferred feedback :

Immediately after the attempt
The attempt
(O Whether correct
O Marks
Specific feedback
General feedback
O Right answer
Qverall feedback

Later, while the quiz is still open
The attempt
[ Whether correct
[ Marks
Specific feedback
General feedback
O Right answer
Overall feedback

Set up the question layout as seen in the image above.

To avoid exam malpractice

Ensure the following are unchecked for all the periods of attempt ( as seen in the image above)

* whether correct
* marks
* right answer

https://ntibay.com
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v Activity completion

Completion tracking e Show activity as complete when conditions are met &
Require view Student must view this activity to complete it
Require grade Student must receive a grade to complete this activity @

O Student must receive a passing grade to complete this activity @

Or all available attempts completed
Require attempts O Minimum number of attempts: 1

Expect completed on (2 Octobe 2023 02 # 7 ¢+ [ Oenable

@
T
&
@
Ll
Ll

> Tags

> Competencies

O Send content change notification @

Save and return to course | Save and display Cancel

D Required

Set up the activity completion section as seen in the image above
Click save and display button

First C.A

View Receive a grade

Opened: Wednesday, 11 October 2023, 2:17 AM
Closes: Wednesday, 11 October 2023, 12:17 PM

Preview quiz

Time limit: 30 mins

Grading method: Highest grade

Click on the preview quiz to attempt

https://ntibay.com
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E Quiz navigation
Back

O

Finish attempt ...

. Question 1 A six-figure grid reference usually have how many numbers?
Start a new preview Not yet
answered O a. Ssixnumbers
Marked out of O b. Five numbers
LD O c. Four numbers
E Navigation € Flag O d. Seven numbers
question
o - 3
~ Dashboard o el
# Site home e
> Site pages
v My courses
v ABS311
> Participants Question 2 are horizontal and vertical lines which make equal squares on a map.
U Badges (it
& Competencies enawered O a. Westlines
B8 Grades Marked out of O b. Gridlines
> General LD O c. Eastings
> Topic1 { Flag O d. Northings
v Topic2 question
[ E- material £ edit !

Attempt all question and click on finish button

Question 7 are horizontal and vertical lines which make equal squares on a map.
Not yet

answered O a. Gridlines

Marked out of O b. Northings

1.00 O ¢ West lines

¢ Flag @® d. Eastings

question Clear my choice

£ Edit

question

rs -
Summary of attempt

Question Status

1 Answer saved
2 Answer saved
3 Answer saved
4 Answer saved
5 Answer saved
(=3 Answer saved
7 Answer saved

Return to attempt

This attempt must be submitted by Wednesday, 11 October 2023, 2:59 AM.

Submi I and ish

Click on the Submit all and finish

https://ntibay.com
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Confirmation

Once you submit, you will no longer be
able to change your answers for this
attempt.

Submit all and finish Cancel

Confirmation prompt

First C.A

View  Receive a grade

Opened: Wednesday, 11 October 2023, 2:17 AM
Closes: Wednesday, 11 October 2023, 12:17 PM

Preview quiz

Time limit: 30 mins

Grading method: Highest grade

Summary of your previous attempts
Attempt State Review

Preview Finished Review
Submitted Wednesday, 11 October 2023, 2:32 AM

https://ntibay.com
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10. Grades

E Navigation

v Dashboard

#& Site home

> Site pages

~ My courses

~ ABS311

> Participants
U Badges
v Competencies
E= Grades
> General
> Topic 1
> Topic2
> Topic3
> Topic4

Click on the grade from the left block of the course page

Grader report
All participants: 1/1

F"St"ameAECDEFGHlJKLMNOPORSTuvwxvz
LaSt”a"‘eABCDEFGH\]KLMNOPQRSTUVWXYZ
Airport Safety & Security=—
o
First name / Last name * Email address [J TestAssignment ¢ & [ FirstCATest$ & [ FirstCAS & ¥ Coursetotal $ &
Controls & -] & &=
& &4 Q o Q k]

Sd  Student demo B ¢ studentdemo@gmail.com ] ‘ ‘ ‘ ‘ ]

Overall average

Save changes

Here is how the grader report look like from the lecture view

https://ntibay.com
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u Administration

~ Grade administration
lés Grader report
| Grade histary
& Overview report
s Single view
| User report
> Setup
> Import
> Export
L Letters
ZeScales

From the Grade administration a lecturer can download result in csv, excel e.t.c

Congrats you are now Supper LMS Lecturer!!
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